Getting Started with Seeed Studio XIAO
ESP32C3

seeed studio|

Mode! XIAD-ESP32-C3

HE CE

FCC Z4T-XIAOESP32C3

Seeed Studio XIAO ESP32C3 is an |oT mini development board based
on the Espressif ESP32-C3 WiFi/Bluetooth dual-mode chip. ESP32-C3 is
a 32-bit RISC-V CPU, which includes an FPU (Floating Point Unit)

for 32-bit single-precision arithmetic with powerful computing power.
It has excellent radio frequency performance, supporting IEEE 802.11
b/g/n WiFi, and Bluetooth 5 (LE) protocols. This board comes included
with an external antenna to increase the signal strength for your
wireless applications. It also has a small and exquisite form-

factor combined with a single-sided surface-mountable design. It is

equipped with rich interfaces and has 11 digital I/0 that can be used


https://manuals.plus/m/89fe89e6fb2c4eaeae86a33637c65c424f0e3e6b9937527190fb1ba726cb84be

as PWM pins and 4 analog 1/0 that can be used as ADC pins. It
supports four serial interfaces such as UART, I12C, SPI and 12S. There is
also a small reset button and a bootloader mode button on the board.
XIAO ESP32C3 is fully compatible with the

and except for the Seeeduino
XIAO Expansion board, the SWD spring contacts on the board will not be

compatible.

With regard to the features highlighted above, XIAO ESP32C3 is
positioned as a high-performance, low-power, cost-effective loT mini
development board, suitable for low-power loT applications and

wireless wearable applications.

This wiki will show you how you can quickly get started with XIAO

ESP32C3!

Features9

« Powerful CPU: ESP32-C3, 32bit RISC-V singlecore processor

that operates at up to 160 MHz

« Complete WiFi subsystem: Complies with IEEE 802.11b/g/n
protocol and supports Station mode, SoftAP mode, SoftAP +

Station mode, and promiscuous mode
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« Bluetooth LE subsystem: Supports features of Bluetooth 5

and Bluetooth mesh

o Ultra-Low Power: Deep sleep power consumption is about

43pA
« Better RF performance: External RF antenna included

« Battery charging chip: Supports lithium battery charge and

discharge management

« Rich on-chip resources: 400KB of SRAM, and 4MB of on-

board flash memory

« Ultra small size: As small as a thumb(20x17.5mm) XIAO
series classic form-factor for wearable devices and small

projects

« Reliable security features: Cryptographic hardware
accelerators that support AES-128/256, Hash, RSA, HMAC,

digital signature and secure boot

« Rich interfaces: 1xI2C, 1xSPI, 1xI2S, 2xUART, 11xGPIO(PWM),

4xADC, 1xJTAG bonding pad interface

« Single-sided components, surface mounting design

Specifications comparisond


https://wiki.seeedstudio.com/XIAO_ESP32C3_Getting_Started/#specifications-comparison

Processor

Wireless
Connectivity

Memory

Built—in
Sensors

Interfaces
PWM/Analog
Pins

Onboard
Buttons
Onboard LEDs

Battery
Charge Chip
Programming
Languages

ESP32-C3 32-bit
RISC-V @160MHz
WiFi and
Bluetooth 5 (LE)
400KB SRAM, 4MB

onboard Flash
N/A
12C/UART/SP1/12S
11/4

Reset/ Boot
Button

Charge LED

Built—in

Arduino

SAMD21
MO+@48MHz
N/A

32KB SRAM
256KB FLASH

N/A

12C/UART/SPT

11/11

N/A

N/A

N/A

Arduino/
CircuitPython

Hardware overviewd

Pinout diagram9

RP2040 Dual-corenRF52840

MO+@133Mhz
N/A

264KB SRAM 2MB
onboard Flash

N/A

12C/UART/SPT
11/4

Reset/ Boot
Button
Full-color RGB/
3—in—one LED
N/A

Arduino/
MicroPython/
CircuitPython

M4F@64MHz
Bluetooth

5. 0/BLE/NFC
256KB RAM, 1MB
Flash 2MB
onboard Flash

N/A

12C/UART/SPI
11/6

Reset Button

3—-in—one LED/
Charge LED
BQ25101

Arduino/
MicroPython/
CircuitPython

nREF52840
M4F@64MHz
Bluetooth
5. 0/BLE/NFC

256KB RAM, 1MB
Flash 2MB
onboard Flash
6 DOF IMU
(LSM6DS3TR-C),
PDM Microphone

12C/UART/SPT
11/6

Reset Button

3-in-one LED/
Charge LED
BQ25101

Arduino/
MicroPython/
CircuitPython
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Component overviewd
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Model X1AOESPIZ-C3

HC (€

FOL Z4T-KIADESPIZC3

RESET BUTTON

WiFi/BT ANTENNA

COMNECTOR
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THERMAL PAD

Power PinsY

« 5V -This is 5v out from the USB port. You can also use this as
a voltage input but you must have some sort of diode
(schottky, signal, power) between your external power source

and this pin with anode to battery, cathode to 5V pin.

« 3V3-This is the regulated output from the onboard regulator.

You can draw 700mA

« GND - Power/data/signal ground

Getting startedd

First, we are going to connect XIAO ESP32C3 to the computer, connect

an LED to the board and upload a simple code from Arduino IDE to
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check whether the board is functioning well by blinking the connected

LED.
Hardware setupd
You need to prepare the following:

e 11X
o 1 x Computer

« 1xUSB Type-C cable
Tip
Some USB cables can only supply power and cannot transfer data. If you don't

have a USB cable or don't know if your USB cable can transmit data, you can
check

o Step 1. Connect XIAO ESP32C3 to your computer via a USB

Type-C cable.
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« Step 2. Connect an LED to D10 pin as follows

seeed studio

Modal XIAQ-ESP32-C3

KE C€

FOC.ZAT-XIAQESPA2C3

1500

UEBEEEE

Note: Make sure to connect a resistor (about 150Q) in series to limit the
current through the LED and to prevent excess current that can burn out

the LED

Software setupd

NOTE: Currently Seeed Studio XIAO ESP32C3 board is not available on
Arduino Board Manager. The board has already been added to esp32
official board libraries but we need to wait until Arduino release the
latest version of the board libraries. The current version is 2.0.3 and
the version after this will have the XIAO ESP32C3 board library.

Because of this, we will manually add the board library.

« Step 1. Download and Install the latest version of Arduino IDE

according to your operating system
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Download Arduino IDE

« Step 2. Launch the Arduino application

« Step 3. Add ESP32 board package to your Arduino IDE

Navigate to File > Preferences, and fill "Additional Boards Manager

URLs" with the url

below: httos.//raw.qgithubusercontent.com/espressit/arduino-esp32/qgh-

pages/package_esp32_dev_index.json
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Navigate to Tools > Board > Boards Manager..., type the keyword

"esp32" in the search box, select the latest version of ****esp32**** and

install it.
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Bonus steps - add XIAO ESP32C3 manually (This step will be changed

after XIAO ESP32C3 shows up on Arduino Board Manager)

Step 4: Navigate
10 c:\Users\<username>\Documents\ArduinoData\packages\esp32\har

dware\esp32\2.0.3\variants and create a new folder

named XIAO_ESP32C3

Step 5: Create a new file called pins_arduino.h and add the following

content

#ifndef Pins Arduino h

#tdefine Pins Arduino h

#include <stdint.h>

ftdefine EXTERNAL NUM INTERRUPTS 22

ttdefine NUM DIGITAL PINS 22

ttdefine NUM ANALOG INPUTS 6

ttdefine analoglnputToDigitalPin (p)

(((p) <NUM_ANALOG_INPUTS) ? (analogChannelToDigitalPin(p)) :=1)
ttdefine digitalPinTolnterrupt (p) (((p)<NUM DIGITAL PINS)?(p):-1)



#define digitalPinHasPWM(p) (p < EXTERNAL_ NUM_INTERRUPTS)

static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const
static const

uint8 t TX = 21;
uint8 t RX = 20;
uint8 t SDA = 6;
uint8 t SCL = 7;
uint8 t SS = 20;
uint8 t MOSI = 10;
uint8 t MISO = 9;
uint8 t SCK = 8;
uint8 t A0
uint8 t Al =
uint8 t A2 =
uint8 t A3 =
uint8 t DO =
uint8 t D1 =
uint8 t D2 =
uint8 t D3 =
uint8 t D4 =
uint8 t Db =
uint8 t D6 =
uint8 t D7 = 20;
uint8 t D8 = 8;
uint8 t D9 = 9;
uint8 t D10 = 10;

Il
N O Ol &= W DN O =~ W o

\)
—

#tendif /* Pins Arduino h */

Step 6: Navigate

10 c:\Users\<username>\Documents\ArduinoData\packages\esp32\har

dware\esp32\2.0.3 and open boards.txt

Step 7: Add the following content at the end of the file

XTAO_ESP32C3

XTAO_ESP32C3

. name=XIAO0 ESP32C3
XIAO ESP32C3.
XIAO ESP32C3.

vid. 0=0x2886
pid. 0=0x0047

.bootloader. tool=esptool py
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.

bootloader. tool. default=esptool py
upload. tool=esptool py

upload. tool. default=esptool py
upload. tool. network=esp ota
upload. maximum size=1310720
upload. maximum data size=327680



XTAO_ESP32C3.
XTAO_ESP32C3.

XTAO_ESP32C3

XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
XTAO ESP32C3.
~menu. CDCOnBoot. cde=Disabled
XTAO ESP32C3.
XTAO ESP32C3.
(1. 2MB APP/1.
XTAO ESP32C3.
XTAO ESP32C3.
(1. 2MB APP/1.
XTAO ESP32C3.

XTAO_ESP32C3

t ffat

XTAO_ESP32C3.

FAT)

XTAO_ESP32C3.

t_8MB

XTAO_ESP32C3.

2336

XTAO_ESP32C3.

SPIFFS)

XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.

upload. flags=

upload. extra flags=

.upload. use 1200bps touch=false
XIAO ESP32C3.

upload. wait for upload port=false
serial. disableDTR=false
serial. disableRTS=false

build.
build.

build

tarch=riscv32
target=esp

.mcu=esp32c3
build.
build.
build.
build.
build.
build.
build.
build.
build.
build.
build.
build.

core=esp3d2
variant=XIAO ESP32C3
bhoard=XIAO ESP32C3
bootloader addr=0x0
cdec on boot=1

{ ¢pu=160000000L
flash size=4MB
flash freq=80m
flash mode=qio
boot=qio
partitions=default
defines=

menu. CDCOnBoot. defaul t=Enabled
menu. CDCOnBoot. default. build. cdc on boot=1

menu. CDCOnBoot. cdc. build. cde on boot=0

menu. Partitionscheme. defaul t=Default 4MB with spiffs

5MB SPIFFS)

menu. PartitionScheme. default. build. partitions=default
menu. Partitionscheme. defaul tffat=Default 4MB with ffat
5MB FATFS)

menu. PartitionScheme. defaultffat. build. partitions=defaul

menu. PartitionScheme. default 8MB=8M Flash (3MB APP/1.5MB

menu. PartitionScheme. default 8MB. build. partitions=defaul

menu. PartitionScheme. default 8MB. upload. maximum size=334

menu. PartitionScheme. minimal=Minimal (1.3MB APP/700KB

menu. PartitionScheme. minimal. build. partitions=minimal
menu. PartitionScheme. no ota=No OTA (2MB APP/2MB SPIFFS)
menu. PartitionScheme. no ota. build. partitions=no _ota

menu. PartitionScheme. no ota. upload. maximum size=2097152



XTAO ESP32C3.
SPIFFS)

XTAO ESP32C3.
XTAO ESP32C3.
6

XTAO ESP32C3.
FATFS)

XTAO ESP32C3.
fat

XTAO ESP32C3.
152

XTAO ESP32C3.
FATFS)

XTAO ESP32C3.
Jgffat

XTAO ESP32C3.
48576

XTAO ESP32C3.
SPIFFS)

XTAO ESP32C3.
XTAO ESP32C3.
8

XTAO ESP32C3. menu

mendu.

mendu.
mendu.

mendu.

mendu.

menu.

menu.

menu.

menu.

menu.

mendu.
menu.

PartitionScheme

PartitionScheme

PartitionScheme

PartitionScheme

.PartitionScheme.

APP with OTA/190KB SPIFFS)

XTAO ESP32C3. menu
ffs

XTAO ESP32C3.
080

XTAO ESP32C3.
FAT)

XTAO ESP32C3.
XTAO ESP32C3.
2

menu

XTAO_ESP32C3. menu.

APP/9MB FATFES)

XTAO_ESP32C3. menu.

pp3M_fat9M_16MB

XTAO_ESP32C3. menu.

©=3145728

XTAO_ESP32C3. menu.
XTAO_ESP32C3. menu.

r

XTAO_ESP32C3. menu.

28

mendu.

mendu.
mendu.

.PartitionScheme.

.PartitionScheme

PartitionScheme

PartitionScheme.

PartitionScheme.

PartitionScheme.

PartitionScheme.

PartitionScheme.

PartitionScheme.

PartitionScheme.

PartitionScheme.

PartitionScheme.
PartitionScheme.

PartitionScheme.

PartitionScheme.

PartitionScheme.
PartitionScheme.

PartitionScheme.

noota 3g=No OTA (IMB APP/3MB

.noota 3g.build. partitions=noota_3g
PartitionScheme.

noota 3g. upload. maximum size=104857

~noota fat=No OTA (2MB APP/2MB

noota ffat.build. partitions=noota f
noota ffat.upload. maximum size=2097
noota Sgftat=No OTA (IMB APP/3MB
noota 3gffat.build. partitions=noota

noota 3gffat. upload. maximum size=10

~huge app=Huge APP (3MB No OTA/1MB

huge app. build. partitions=huge app

. huge app. upload. maximum size=314572

min spiffs=Minimal SPIFFS (1.9MB

min spiffs.build. partitions=min spi

.min spiffs.upload. maximum size=1966

fatflash=16M Flash (2MB APP/12. 5MB

fatflash. build. partitions=ffat
fatflash. upload. maximum size=209715

appsM fatoM 16MB=16M Flash (3MB

.app3M fat9M 16MB. build. partitions=a

app3M fat9M 16MB. upload. maximum siz

rainmaker=RainMaker
rainmaker. build. partitions=rainmake

rainmaker. upload. maximum size=31457



XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.
XTAO_ESP32C3.

menu.
menu.
. CPUFreq.

menu

menu.
menu.
menu.
menu.
menu.
. CPUFreq.

menu

menu.
menu.
menu.
menu.
menu.
menu.
menu.
menu.
mendu.
menu.
mendu.
mendu.
mendu.
menu.
mendu.
mendu.
mendu.
mendu.
menu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.
mendu.

CPUFreq.
CPUFreq. 160.
CPUFreq.
CPUFreq.
CPUFreq.
CPUFreq.
CPUFreq.

CPUFreq.
FlashMode.
FlashMode.
FlashMode.
FlashMode.
FlashMode.
FlashMode.
FlashMode.
FlashMode.
FlashMode.
FlashMode.
FlashMode.
FlashFreq.
FlashFreq.
FlashFreq.
FlashFreq.
FlashSize.
FlashSize.
FlashSize.
FlashSize.
FlashSize.
FlashSize.
FlashSize.
FlashSize.
FlashSize.
FlashSize.
UploadSpeed.
UploadSpeed.
UploadSpeed.
UploadSpeed.
UploadSpeed.
UploadSpeed.
UploadSpeed.
UploadSpeed.
UploadSpeed.

160=

160MHz (WiFi)
build. £ cpu=160000000L

80=80MHz (WiFi)

80. build. £ ¢pu=80000000L
410=40MHz

A0, build. £ ¢pu=40000000L
20=20MHz
20.build. £ ¢pu=20000000L
10=10MHz

10. build. £ ¢pu=10000000L
q10=QI0

qio. build. flash mode=dio
qio.build. boot=qio

di0=DI0

dio. build. flash mode=dio
dio.build. boot=dio
qout=QOUT

gout. build. flash mode=dout
qout. build. boot=qout
dout=DOUT

dout. build. flash mode=dout
50=80MHz

80. build. flash freq=80m
10=40MHz

40. build. flash freq=40m
A\=4MB (32Mb)

AM. build. flash size=4MB
8\1=8MB  (64Mb)

8M. build. flash size=8MB
SM. build. partitions=default 8MB
2)=2MB  (16Mb)

2M. build. flash size=2MB
M. build. partitions=minimal
16)=16MB (128Mb)

16M. build. flash size=16MB

921600=921600
921600. upload. speed=921600
115200=115200

115200, upload. speed=115200

256000, windows=256000

256000, upload. speed=256000

230400. windows. upload. speed=256000
230400=230400

230400, upload. speed=230400



=460800

=460800
=460800
=512000
=512000
=None
=0
=Error
=1
=Warn
=2
=Info
=3
=Debug
=4
=Verbose
=5

Now we have manually added the XIAO ESP32C3 board.

« Step 8. Select your board and port

Board

Navigate to Tools > Board > ESP32 Arduino and select

"XIAO_ESP32C3"

Port

Navigate to Tools > Port and select the serial port name of the
connected XIAO ESP32C3. This is likely to be COM3 or higher

(COM1 and COM2 are usually reserved for hardware serial ports).

Blink the LEDY
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« Step 1. Copy the below code to Arduino IDE

// define led according to pin diagram

int led = DI10;

void setup() |

// Initialize digital pin led as an output
pinMode (1ed, OUTPUT) ;

}

void loop() {

digitalWrite(led, HIGH); /. turn the LED on
delay (1000) ; // wait for a second
digitalWrite(led, LOW); ./ turn the LED off
delay (1000) ; // wait for a second

}

« Step 2. Click the Upload button to upload the code to the

board

&9 Blink | Arduino 1.6.9 - O x

File Edit Sketch Tools Help

Once uploaded, you will see the connected LED blinking with a 1-second
delay between each blink. This means the connection is successful and

now you can explore more projects with XIAO ESP32C3!
FAQY
Q1: My Arduino IDE is stuck when uploading code to the boardd

You can first try to reset the board by clicking the RESET BUTTON once

while the board is connected to your PC. If that does not work, hold
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the BOOT BUTTON, connect the board to your PC while holding

the BOOT button, and then release it to enter bootloader mode.

Q2: My board is not showing up as a serial device on Arduino IDEY

Follow the same answer as for Q1 above.

Q3: | want to reflash the bootloader with factory firmwared

You can simply connect the board to a PC via USB Type-C and reflash

the bootloader with factory firmware by using ESP RF Test Tool.
« Step 1. Hold on the BOOT BUTTON and connect XIAO
ESP32C3 to the PC to enter bootloader mode
« Step 2. After it is connected, release the BOOT BUTTON

« Step 3. Visit and download ESP RF Test Tool and

Test Guide
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« Step 4. Extract the .zip, navigate
10 ESP RF Test EN\ESP RF Test EN\EspRFTestTool v2.8 Ma

nual and open EspRFTestTool_v2.8_Manual.exe

ISP RF Tl EM & F5P_BF Tesdl EM & oo wd A_Manual

o Step 5. Select ESP32C3 as the ChipType, your COM

port, 115200 as the BaudRate and click open



8 ' EspPFiesiTool — | ¥

Tonf  Halp
Kianniil Tagr
CgType | ESFIZCT Irillh' COMI . BeudRals | 115304 ll:l:-crl cias
Rl Seks Bin
0L
=] Load B
You will see the following output
Log
DEBUG:['COM1', 'COM3', 'COMa', "COMS"]
set to com port!
Com3 is open serl(
DEBUG:open com3 sucess
« Step 6. Select Flash and click Select Bin
B | EspRFTestTool — O >
Toocl  Help
Mannul Test
ChipType |ESP32C3 ~  COM COM3 ~ BaudRate 115200 ~ | open close
Flash ~ Select Bin
IDLE
03 Load Bin
WiFi Tert AT Teat WAIFi A dantivi Kannal

« Step 7. Select the file starting with ESP32-C3 and click Open



« Step 8. Finally click Load Bin

| EapfAFTetTool = O b
Tool  Help

WA Grir il TRET

ChpType ESPI2CE CON COME Boudfiale  §153200 o
Fiaah Egiepd gen
Ty Lomd B

You will see the following output when flashing is successful



B | EspRFTestToo =
Tool  Help

Mannul Test

ChipType | ESP32C3 w  COM COM3 “~  BaudRate @ 115200 ~ DpEn close

MAC-10:91:a8:03:5a:1c  3_AFTest 108 2bSbi57 20211014bin | Flash v | | Select Bin

I oo | Loadein

WiFi Test BT Test WiFiAdaptivity Manual

SUCC

Test Mode- WWiFi Rate- Band\/dith: Channel-
TX continues e T 1M “w 20M e 12412 R
Attenuation(0.25dB) Duty Cycle; : Certification EN Certification Code:
0 default Ot o000 SRRC
start siop
Lag

LIEGU  WNTILTY dL UXUUUULCUULL... |00 o )

DEBUG:Writing at 0x00010000... (83 %)

DEBUG:Writing at 0x00014000... (100 %)

DEBUG:Wrote 150656 bytes (88631 compressed) at 0x00000000 in 2.0
seconds (effective 608.1 kbit/s)...

WARNING:Hash of data verified.

DEBUG:Leaving...

DEBUG:Load bin success! L_I-Showe Send
set to com port! | Show Time
Com3 is open ser( Log Clear
DEBUG:open com3 sucess

Log Save

WiFi Usage

Seeed Studio XIAO ESP32C3 supports WiFi connectivity with IEEE
802.11b/g/n. This wiki will introduce the basics of WiFi usage on this

board.

Hardware set up94


https://wiki.seeedstudio.com/XIAO_ESP32C3_WiFi_Usage/#hardware-set-up

« Step 1. Connect the included WiFi/ Bluetooth antenna to

the IPEX connector on the board

» Step 2. Connect XIAO ESP32C3 to your computer via a USB

Type-C cable



Scan WiFi networks (Station Mode)d

In this example, we are going to use XIAO ESP32C3 to scan available
WiFi networks around it. Here the board will be configured in Station

(STA) Mode.

« Step 1. Copy and paste the code below into Arduino IDE

#include "WiFi.h”

void setup()

{

Serial. begin(115200) ;

// Set WilFi to station mode and disconnect from an AP if it was
previously connected

WiFi. mode (WIFI STA) ;

WiFi. disconnect () ;

delay (100) ;

Serial.println(“Setup done”) ;

}
void loop()

{

Serial.println(“scan start”);
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/7 WiFi. scanNetworks will return the number of networks found
int n = WiFi. scanNetworks () ;
Serial.println(“scan done”);

if (n==0) {

Serial. println("no networks found”) ;

} else {

Serial. print (n) ;

Serial.println(” networks found”);

for (int 1 =0; i < n; ++i) {

// Print SSID and RSSI for each network found
Serial.print(i + 1);

Serial.print (": 7);

Serial. print (WiFi. SSID(i)) ;

Serial.print(” (7);

Serial. print (WiFi.RSSI(i));

Serial. print(”)”);

Serial. printIn((WiFi. encryptionType (i) == WIFI AUTH OPEN)?” ”:”%");
delay (10) ;

}

}

Serial. printIn(””);

/) Wait a bit before scanning again

delay (5000) ;

}

Step 2. Upload the codes and open the Serial Monitor to start scanning

for WiFi networks



16:07:02.40)% =>» Setup donea
16:0Q /202,401 =2 scan starct
16:07=02,.401 => scan done
16:07:02.401 ->» 4 networks found
16:07:02.401 -> 1: Z2nd Floor V1 (-64)*
16:07:02.401 -> 2: Znd Floor Wz (=T1)*
16:07:02.401 —> 3:; Dialog 4G 034 {-83)*
E:07:02.40F == 4+ walawedura (=-BB)*
G:07:02.,.401 ->

BrlQYy:02.401 => acan start

16:07:02.401 <> scan done

16:07:02,401 -» 4 networks found
16:07:02.401 => 1: 2nd Floor V1 (=-63)*
16:07:02.401 -> 2: 2nd Floor V2 (-69)*
1b:0V:0d. 401 => 3: Malog 46 034 (=Ha) ™

TH=2011 =02 A01 =2 A= walawedura (=HA1*
[- e N Er ST W Lk — b® mran

Connect to a WiFi network9

In this example, we are going to use XIAO ESP32C3 to connect to a WiFlI

network.

« Step 1. Copy and paste the code below into Arduino IDE

#include <WiFi.h>

const char* ssid = “your—ssid”;

const char* password = “your—password”;
void setup()

{

Serial. begin(115200) ;

delay (10) ;

// We start by connecting to a WiFi network
Serial. println();

Serial. println();
Serial. print (“Connecting to ”):

Serial. println(ssid);

WiFi. begin(ssid, password)

while (WiFi.status() != WL_CONNECTED) {
delay (500) ;
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” 7

Serial.print(”.”):
}
Serial.println(””);
Serial.println("WiFi connected”) ;
Serial.println(“IP address: 7):
Serial. println (WiFi. localIP()) ;
}

Loop ()
{
}

Step 2. Upload the codes and open the Serial Monitor to check that the

board is connected to the WiFI network

& o
l6:11:08.316 ->

lez11:08.316 ==

16:11:08.316 -> Connecting to 2Znd Floor V1
lE211:08.316 -> ....

16:211:08.316 => WiFi connected

l&6:11:08.316 —-> IP addaress:

1621108, 31+« = 1492 .168.2.11¢

Use as an Access Point94

In this example, we are going to use XIAO ESP32C3 as a WiFi access
point where other devices can be connected to it. This is similar to WiFi

hotspot feature on mobile phones.

« Step 1. Copy and paste the code below into Arduino IDE

#include “"WiFi.h”

void setup()

{

Serial. begin(115200) ;

WiFi. softAP ("ESP_AP”, 7123456789”) ;
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}
void loop()

{

Serial. print ("Host Name:”) ;
Serial.println (WiFi. softAPgetHostname ()) ;
Serial.print ("Host IP:”);
Serial.println (WiFi. softAPIP()) ;

Serial. print ("Host TPV6:”):
Serial.println (WiFi. softAPIPv6()) ;
Serial. print ("Host SSID:”);

Serial. printIn(WiFi. SSID()) ;

Serial. print ("Host Broadcast IP:”);
Serial. printIn(WiFi. softAPBroadcastIP()) ;
Serial. print ("Host mac Address:”);
Serial. printIn(WiFi. softAPmacAddress()) ;
Serial. print ("Number of Host Connections:”):
Serial. printIn(WiFi. softAPgetStationNum()) ;
Serial. print ("Host Network ID:”):

Serial. printIn(WiFi. softAPNetworkID()) ;
Serial. print ("Host Status:”):

Serial. printIn(WiFi. status());

delay (1000) ;

}

Step 2. Upload the codes and open the Serial Monitor to check more

details about the WiFl access point

I =2 Number of Hodt Connactionssi



Step 3. Scan for WiFi networks on a PC or mobile phone and you will be
able to connect to this newly created network using the password we

specified in the code

‘ 20d Fooc V1

% 2rd Floor V2

’:'a Dislog 4G 034

Now you will see that the Number of Host Connections on serial

monitor has been updated to 1

Bluetooth Usage

Seeed Studio XIAO ESP32C3 supports Bluetooth 5 (LE) connectivity.

This wiki will introduce the basics of Bluetooth usage on this board.



Hardware set up94

« Step 1. Connect the included WiFi/ Bluetooth antenna to

the IPEX connector on the board

« Step 2. Connect XIAO ESP32C3 to your computer via a USB

Type-C cable
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Scan Bluetooth devicest

In this example, we are going to use XIAO ESP32C3 to scan available

Bluetooth devices around it.

« Step 1. Copy and paste the code below into Arduino IDE

#include <BLEDevice. h>

#include <BLEUtils.h>

#include <BLEScan. h>

#include <BLEAdvertisedDevice. h>
scanTime = 5; ///n seconds

BLEScan* pBLEScan;

BLEAdvertisedDeviceCallbacks {

onResult (BLEAdvertisedDevice advertisedDevice) {
Serial. printf (“Advertised Device: %s \n”,
advertisedDevice. toString().c str());

}
I
setup () {
Serial. begin(115200) ;
Serial.println(”“Scanning...”);
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BLEDevice::init (") ;

pBLEScan = BLEDevice::getScan(); /create new scan
pBLEScan—>setAdvertisedDeviceCallbacks (
MyAdvertisedDeviceCallbacks()) ;

pBLEScan—>setActiveScan ( ): /Jactive scan uses more power, but get
results faster

pBLEScan—>setInterval (100) ;

pBLEScan—>setWindow (99) ; /' /ess or equal setlnterval value
}
loop O {
// put your main code here, to run repeatedly:
BLEScanResults foundDevices = pBLEScan—->start (scanTime, )

Serial. print ("Devices found: ”);

Serial. println(foundDevices. getCount()) ;

Serial. println(“Scan done!”):

pBLEScan—>clearResults(); // delete results frombBlLEScan buffer to
release memory

delay (2000) ;
}

Step 2. Upload the codes and open the Serial Monitor to start scanning

for Bluetooth devices

XIAO ESP32C3 as Bluetooth serverq

In this example, we are going to use XIAO ESP32C3 as a Bluetooth
server. Here we will search for XIAO ESP32C3 board using a

smartphone and send out strings to display on the serial monitor
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« Step 1. Copy and paste the code below into Arduino IDE

#include <BLEDevice.h>
#include <BLEUtils. h>
#include <BLEServer.h>
// See the following for generating UUIDs:
s/ https://www. uuidgenerator. net/
#tdefine SERVICE UUID “4fafc201-1fb5-459e-8fcc—c5c9¢331914bh”
#tdefine CHARACTERISTIC UUID “beb5483e-36el1-4688-h7f5-eal07361b26a8”
BLECharacteristicCallbacks {

onWrite (BLECharacteristic #*pCharacteristic) {

std::string value = pCharacteristic—>getValue();
(value. length() > 0) {

Serial. println (“seksoksokorkr”) ;
Serial. print ("New value: ”);

( i =0; i < value. length(); i++)
Serial. print (valueli]);
Serial. println() ;
Serial. println (“sssskskkiolk”) ;
}
}
I

setup () {
Serial. begin(115200) ;
BLEDevice::init ("MyESP32”) ;
BLEServer *pServer = BLEDevice::createServer();
BLEService *pService = pServer—>createService (SERVICE UUID) ;
BLECharacteristic *pCharacteristic = pService—>createCharacteristic(
CHARACTERISTIC UUID,
BLECharacteristic: :PROPERTY READ |
BLECharacteristic: :PROPERTY WRITE
);
pCharacteristic—>setCallbacks ( MyCallbacks()) ;
pCharacteristic—>setValue (“"Hello World”);
pService—>start () ;
BLEAdvertising *pAdvertising = pServer—>getAdvertising();
pAdvertising—>start () :
}

loop O {
// put your main code here, to run repeatedly:
delay (2000) ;
}

« Step 2. Upload the codes and open the Serial Monitor



« Step 3. Download and install LightBlue App on your

smartphone

« Step 4. Open Bluetooth on your phone, bring the phone close
to XIAO ESP32C3, scan for devices and connect

with MyESP32 device

AVAILABLE DEVICES

® MyESP32

Additional settings

« Step 5. Open the LightBlue app and click Bonded tab

o Step 6. Click CONNECT next to MyESP32

10:26 PM AN ED

LightBlue®

CONNECT

4 MyESP32

1 TE



https://play.google.com/store/apps/details?id=com.punchthrough.lightblueexplorer&hl=en_US&gl=US
https://apps.apple.com/us/app/lightblue/id557428110

Step 7. Click the section at the very bottom which

says Readable, Writable

W81 EM 5.0

e

- :-\. ,:' MATI ‘_—_' .’J

Step 8. Under Data format drop-down menu, select UTF-8

String



& 20w ED

beb5483e-36e1-4688-b7f5.,

UTF-8 String

Binary

Unsigned Little-Endian

Signed Little~-Endian

Unsigned Big-Endian

Signed Big~Endian

Hox
READ/INDICATED VALUES

READ AGAIN

Step 9. Type "Hello" under WRITTEN VALUES and

click WRITE



028 BM ® 5. .0TED

€ beb5483e-36e1-4688-b715.,

UTF~8 String

EAD/INDICATED VALUES

You will see the text string "Hello" output on the serial monitor of

Arduino IDE

B oM o

27:51:720,00] —» wkdkhkkikk

22:51:29.991 -> New wvalue: Hello

22:51:29.991 -3 *kakwkads

]



Pin Multiplexing

Seeed Studio XIAO ESP32C3 has rich interfaces. There are 11 digital
I/0 that can be used as PWM pins and 4 analog inputs that can be used
as ADC pins. It supports four serial communication interfaces such

as UART, I2C, SPI and 12S. This wiki will be helpful to learn about these

interfaces and implement them in your next projects!
Digital®

Connect a pushbutton to Pin D6 and an LED to Pin D10. Then upload the

following code to control the ON/OFF of LED using the pushbutton.

buttonPin = D6; /. pushbutton connected to digital pin 6

ledPin = D10: // LED connected to digital pin 10
buttonState = 0; // variable for reading the pushbutton status
setup () {

"/ Initialize the LED pin as an output:
pinMode (1edPin, OUTPUT) ;
/' Initialize the pushbutton pin as an input:
pinMode (buttonPin, INPUT) ;
}
loop O {

// read the state of the pushbutton value:
buttonState = digitalRead(buttonPin) ;
// check it the pushbutton is pressed. If it is, the buttonState Is
HIGH:

(buttonState == HIGH) {
// turn LED on:
digitalWrite(ledPin, HIGH) ;
} {
// turn LED off:
digitalWrite(ledPin, LOW);
}
}
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Digital as PWMY

Connect an LED to Pin D10. Then upload the following code to see the

LED gradually fading.

ledPin = D10; // LED connected to digital pin 10
setup () {

// declaring LED pin as output

pinMode (1ed pin, OUTPUT) ;

}
loop () f{

// fade In from min to max in Increments of & points:
( fadeValue = 0 ; fadeValue <= 255; fadeValue += 5) {

// sets the value (range from 0 to 255):

analogWrite (ledPin, fadeValue) ;

s/ wait for 30 milliseconds to see the dimming effect

delay (30) ;

}

// fade out from max to min in increments of 5 points:
( fadeValue = 255 ; fadeValue >= 0; fadeValue —= 5) {

// sets the value (range from 0 to 255):

analogWrite (ledPin, fadeValue) ;

// wait for 30 milliseconds to see the dimming effect

delay (30) ;

}

}

Analog¥

Connect a potentiometer to Pin A0 and an LED to Pin D10. Then upload
the following code to control the blinking interval of the LED by rotating

the potentiometer knob.

sensorPin = AQ;
ledPin = D10;
setup () {
pinMode (sensorPin, INPUT); // declare the sensorPin as an INPUT
pinMode (1edPin, OUTPUT); /. declare the ledPin as an OUTPUT
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loop () {
/' read the value from the sensor:
sensorValue = analogRead (sensorPin) ;
/' turn the ledPin on
digitalWrite (ledPin, HIGH) ;
'/ stop the program for <sensorValue> milliseconds:
delay (sensorValue) ;
// turn the ledPin off:
digitalWrite (1edPin, LOW);
/' stop the program for for <sensorValue> milliseconds:
delay (sensorValue) ;

}

Serialq

There are 2 serial interfaces on this board:

« USB Serial
« UARTO Serial
By default, USB serial is enabled, which means you can connect the

board to a PC via USB Type-C and open serial monitor on Arduino IDE to

view data sent via serial.

However, if you want to use UARTO as the serial, you need to connect

pin D6 as the TX pin and pin D7 as RX pin with a USB-Serial adapter.
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Also, you need to set USB CDC On Boot to Disabled from Arduino IDE.

NOTE: Change photo when board shows up on Arduino Board Manager
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Upload the following code to Arduino IDE to send the string "Hello

World!" via serial

void setup() {
Serial. begin(115200) ;
while (!Serial);

}



void loop() {

Serial. println(“Hello World!”):
delay (1000) ;

}

The output will be as follows on Arduino Serial Monitor

& Do 2 =

23:16:050.456 =-> Hello World!
23:16:05,.456 => Hello World!
23:16:05:456 => Hello Worldl
23:16:05.456 => Hello Warld!
23:16:06.477 => Hello World!
£23:16:07.454 => Hello World!
23:16:0B.474 -> Hello World!
23:16:059.4895 => Hello World!
23:16:10.466 -> Hello Worldl
23:16:11.484 -> Hello Warld!
£3:16:12.458 => Hello Worldl
23:16:13.477 -> Hello Warld!
23:16:14.495 => Hello World!
23:16:15:468 => Hella Worla!l

W evwma W vwvn rvanes hi b St HEr= -5 + H il

12CY
Hardware connectiond

Connect a Grove - OLED Yellow&Blue Display 0.96 (SSD1315) to XIAO

ESP32C3 by following the hardware connection as follows.

SCL SCL
SDA SDA
VCC oV

GND GND


https://wiki.seeedstudio.com/XIAO_ESP32C3_Pin_Multiplexing/#i2c
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https://www.seeedstudio.com/Grove-OLED-Yellow-Blue-Display-0-96-SSD1315-V1-0-p-5010.html

Hlla World!

Hella Warld!

LB N NN NN

Software setupd

« Step 1. Open Arduino IDE, navigate to sketch > TInclude

Library > Manage Libraries...

o Step 2. Search for u8g2 and install it

O Litrary Manager
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« Step 3. Upload the following code to display text strings on

the OLED Display

//#include <Arduino. h>
#tinclude <U8g2lib. h>
#tifdef USX8 HAVE HW SPI
#include <SPI.h>
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#tendif

#ifdef USX8 HAVE HW I2C

#include <Wire.h>

#tendif

U8G2 SSD1306 128X64 NONAME F SW 12C u8g2(U8G2 RO, * c/ock=+#/SCL, /*
data=+/SDA, /# reset=+/U8X8 PIN NONE); //Low spped 12C

void setup(void) {

u8g2. begin() ;

/7 u8x8. setFlipMode (1); // set number from 1 to 3, the screen word
will rotary 180

}

void loop (void) {

u8g2. clearBuffer(); // clear the internal memory

u8g2. setFont (u8g2 font ncenB08 tr); /. choose a suitable font
u8g2. drawStr (0, 15, "Hello World!”); // write something to the internal
memory

u8g2. drawStr (0, 30, “Hello World!”);

u8g2. drawStr (0, 40, “Hello World!”);

u8g2. sendBuffer(); // transter internal memory to the display

// delay (1000) ;

}

SPIY
Hardware connectiony

Connect a Grove - High Precision Barometric Pressure Sensor

(DPS310) to XIAO ESP32C3 by following the hardware connection as

follows.

3V3 3V3

SDI MOSI
GND GND

SDO MISO
CSK SCK

CS CS


https://wiki.seeedstudio.com/XIAO_ESP32C3_Pin_Multiplexing/#spi
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https://www.seeedstudio.com/Grove-High-Precision-Barometer-Sensor-DPS310-p-4397.html
https://www.seeedstudio.com/Grove-High-Precision-Barometer-Sensor-DPS310-p-4397.html

Software setupd

« Step 1. Download as a zip file

« Step 2. Open Arduino IDE, navigate t0 sketch > Include

Library > Add .zIP Library... and open the downloaded

zip file


https://wiki.seeedstudio.com/XIAO_ESP32C3_Pin_Multiplexing/#software-setup_1
https://github.com/Seeed-Studio/Seeed_Arduino_DPS310
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o Step 3. Navigateto rile > Examples >
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Alternatively you can copy the code from below as well

#tinclude <Dps310.h>
// Dps310 Opject
Dps310 Dps310PressureSensor = Dps310() ;



void setup() {

//pin number of your slave select line

//XNC260

intl6 t pin cs = SS;

//for XMC 1100 Bootkit & XMC41700 Relax Kit uncomment the following
line

//intl6 t pin cs = 10;

Serial. begin(9600) ;

while (!Serial);

//Call begin to initialize Dps310

//The parameter pin nr is the number of the CS pin on your
Microcontroller

Dps310PressureSensor. begin(SPI, pin cs);

//temperature measure rate (value from 0 to 7)

/72Atempimr temperature measurement results per second

intl6 t temp mr = 2;

//temperature oversampling rate (value from O to 7)

//2 temp osr internal temperature measurements per result

//A higher value increases precision

intl6 t temp osr = 2;

//pressure measure rate (value from 0 to 7)

//2 prs mr pressure measurement results per second

intl6 t prs mr = 2;

//pressure oversampling rate (value from 0 to 7)

//2 prs osr internal pressure measurements per result

//A higher value increases precision

intl6 t prs osr = 2;

//startMeasureBothCont enables background mode

//temperature and pressure ar measured automatically

//High precision and hgh measure rates at the same time are not
available.

//Consult Datasheet (or trial and error) for more information
intl6 t ret = Dps310PressureSensor. startMeasureBothCont (temp mr,
temp osr, prs mr, prs Osr):

//Use one of the commented lines below instead to measure only
temperature or pressure

//intl6 t ret = Dps310PressureSensor. startMeasurelempCont (temp mr,
temp osr);

//intl6 t ret = Dps310PressureSensor. startMeasurePressureCont (prs mr,
prs_osr);

if (ret !=0) {

Serial.print (“Init FAILED! ret = 7);

Serial.println(ret) ;

I else {



Serial.println(“Init complete!”);

}

}

void loop() {

uint8 t pressureCount = 20;

float pressure[pressureCount];

uint8 t temperatureCount = 20;

float temperature[temperatureCount];

//This function writes the results of continuous measurements to the
arrays given as parameters

//The parameters temperatureCount and pressureCount should hold the
sizes of the arrays temperature and pressure when the function i1s
called

//After the end of the function, temperatureCount and pressureCount
hold the numbers of values written to the arrays

//Note: The Dps310 cannot save more than 32 results. When its result
buffer is full, it won’t save any new measurement results

intl6 t ret = Dps310PressureSensor. getContResults (temperature,
temperatureCount, pressure, pressureCount)

if (ret !=0) {

Serial. println();

Serial. println();

Serial. print ("FAIL! ret = 7):

Serial. println(ret) ;

} else {

Serial. println();

Serial. println();

Serial. print (temperatureCount) ;

Serial. println(” temperature values found: ”);

for (intl6 t i = 0; 1 < temperatureCount; i++) {

Serial. print (temperaturel[i]) ;

Serial.println(” degrees of Celsius”);

}

Serial. println();

Serial. print (pressureCount) :

Serial.println(” pressure values found: ”);

for (intl6 t i =0; 1 < pressureCount; i++) {
Serial. print (pressurel[i]) ;

Serial.println(” Pascal”);

}

}

//Wait some time, so that the Dps310 can refill its buffer
delay (10000) ;

}



« Step 4. Upload the codes and open the Serial Monitor

Note: Once you upload the codes, it will not be executed automatically
until you click Serial Monitor on the upper right corner of the Arduino

window.

r

oce Jdevjcu. usbmodem21401

14:26:45.430 > 16 tesparature volues found!
14:26:45.430 > 26.72 degrees of Celsius
114:26:45.430 -> 26.72 degrees of Celsius
14:26:45.430 -> 26.71 degrees of Celsius
14:26:45.430 > 26.71 degrees of Celsius
14:26:45.430 -» 26.72 degrees of Celsius
14:26:45.430 > 26.73 degrees of Celsius
14:26:45.438 -> 26.79 degrees of Celsius
JA:26:45.430 > 26,72 dogrees of Celsius
14:26:45.430 -» 26.71 degrees of Celstius
14:26:45.430 > 26.72 degrees of Celsius
14:26:45.450 -> 26.71 degrees of Colsius
114:26:45.400 > 26.72 degroes of Celsius
14:26:45.430 > 26.72 degrees of Celstius

14:26:45.430 > 26.73 degrees of Celsius
14:26:45.430 > 26.71 degrees of Celsius
1A:26:45.430 > 26.71 degrees of Celsius
14:26:45.430 -

14:26:45.430 > 16 pressure values found:
14:26:45.430 -» 99844 84 Poscal
14:26:45.430 > 99844 92 Pascal
14:26:45.430 -> 99844 .00 Pascal
14:26:45.430 -> 99844.27 Pascal
114:26:45 .43 -» 99844 16 Pascol
14:26:45.430 -> 99845.08 Pascal
14:26:45.439 -> 95844.75 Pascal
14:26:45.430 > 99843.55 Pascel
14:26:45.430 -» 99844 14 Pascal
14:26:45.430 -> 99843 .22 Poscal
14:26:45.430 -> 99844 31 Pascel
14:26:45.450 > 99844 49 Pascal
14:26:45.430 > 99544 @9 Pascal
14:26:45.430 -> 99545.19 Pascal
14:26:45,430 > 95844 .47 Pascal
14:26:45.450 > 95844 .07 Pascal

Autoscroll Show timestamp

Now you will see the temperature and pressure data displayed one after

the other on the serial monitor as above!

Federal Communication Commission (FCC) Radiation Exposure Statement



This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled
environment. When using the product, maintain a distance of 20cm from the body to ensure
compliance with RF exposure requirements.

This device complies with part 15 of the FCC rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.
NOTE: The manufacturer is not responsible for any radio or TV interference caused by
unauthorized modifications or changes to this equipment. Such modifications or changes could
void the user’s authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This equipment
generates uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

-Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected.

-Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible
for compliance could void the user's authority to operate this equipment.



ORIGINAL EQUIPMENT MANUFACTURER (OEM) NOTES

The OEM must certify the final end product to comply with unintentional radiators (FCC Sections
15.107 and 15.109) before declaring compliance of the final product to Part 15 of the FCC rules and
regulations. Integration into devices that are directly or indirectly connected to AC lines must add
with Class II Permissive Change.

The OEM must comply with the FCC labeling requirements. If the module” s label is not visible
when installed, then an additional permanent label must be applied on the outside of the finished
product which states: “Contains transmitter module FCC ID: Z4T-XIAOESP32C3.
Additionally, the following statement should be included on the label and in the final product” s
user manual: “This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interferences, and

(2) this device must accept any interference received, including interference that may cause
undesired operation.”

The module is allowed to be installed in mobile and portable applications

A module or modules can only be used without additional authorizations if they have been tested
and granted under the same intended end - use operational conditions, including simultaneous
transmission operations. When they have not been tested and granted in this manner, additional
testing and/or FCC application filing may be required. The most straightforward approach to address
additional testing conditions is to have the grantee responsible for the certification of at least one of
the modules submit a permissive change application. When having a module grantee file a
permissive change is not practical or feasible, the following guidance provides some additional
options for host manufacturers. Integrations using modules where additional testing and/or FCC
application filing(s) may be required are: (A) a module used in devices requiring additional RF
exposure compliance information (e.g., MPE evaluation or SAR testing); (B) limited and/or split
modules not meeting all of the module requirements; and (C) simultaneous transmissions for
independent collocated transmitters not previously granted together.

This Module is full modular approval, it is limited to OEM installation ONLY.

Integration into devices that are directly or indirectly connected to AC lines must add with Class 11
Permissive Change. (OEM) Integrator has to assure compliance of the entire end product include
the integrated Module. Additional measurements (15B) and/or equipment authorizations (e.g.
Verification) may need to be addressed depending on co-location or simultaneous transmission
issues if applicable. (OEM) Integrator is reminded to assure that these installation instructions will
not be made available to the end user
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